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Introduction

PST Importer is an extension to the Metalogix Archive Manager for Exchange application and is
installed by default on the Metalogix Archive Manager for Exchange server. It is a handy tool for
importing PST files from one or more users in your organization. If there are a small set of PST
files, you can import these PST files manually. If there are a large number of users, you can install
the PST Gatherer component as an application or service on a user's computers and automate the
process of searching and loading the PST files into the PST Importer. This document describes
manual and automated importing in detail.

The term PST Importer server is used in this documentation. It is the same as the Metalogix
Archive Manager for Exchange server where PST Importer is installed.
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Installation

In this topic:

e Software Requirements

e Configuring Extended MAPI

e Installing PST Importer

Software Requirements
e Windows Server 2012 / 2016/ 2019 / 2022
o NET Framework 4.6.1 or higher
e Microsoft Outlook 32 bit client
o For Exchange 2013, Outlook 2013 is needed.
o For Exchange 2016, Outlook 2013 or 2016 is needed.

o For Exchange 2019, Outlook 2019 or 2021 is needed.

1 | NOTE: All versions of Outlook specified above require the latest Microsoft Office service
pack and public updates.

Configuring Extended MAPI

Since Microsoft Outlook data files (PST files) are handled exclusively by Microsoft Outlook
Extended MAPI (the messaging APl used by Microsoft Outlook), it is necessary to configure it
properly on the computer where importing of PST files takes place. PST Importer works with two
types of PST files: ANSI data files and UNICODE data files.

The default Extended MAPI cannot handle Microsoft Outlook data files, unless its configuration
file (MAPISVC.INF) contains messaging services to handle them. Therefore all messaging services
installed on the computer must be added to the MAPISVC.INF file.

e When no Microsoft Outlook is installed, then the MAPISVC.INF file is located in the c:
\Windows\system32 Windows system folder, and the Extended MAPI configuration is read
from this file.

e \When Microsoft Outlook is installed, then another MAPISVC.INF file is installed in the C:
\Program Files\Common Files\System\MSMAPI\1003 folder, whichincludesthe
messaging services for Microsoft Outlook.

Metalogix Archive Manager for Exchange PST Importer Guide

Installation



Since PST Imported uses the default MAPISVC.INF file is located in the Windows system folder,
this file must be updated with the Microsoft Outlook Extended MAPI file. To update Extended
MAPI configuration file (MAPISVC.INF), follow these steps:

1. Locate the MAPISVC.INF in the C: \Windows\system32 Windows system folder.

2. Locate the MAPISVC.INF inthe C:\Program Files\Common Files\System\MSMAPI\1003
folder.

3. Make a backup copy of both files.

4. Replace the MAPISVC.INF file in the Windows system folder with the file located in the the c:
\Program Files\Common Files\System\MSMAPI\1003 folder. This will ensure that
Extended MAPI will be using the correct configuration file. If messaging services are missing in
the MAPISVC.INF file, no importing of Microsoft Outlook data files (PST files) will take place.
Note that some of the values are different on different computers. For more information see
Troubleshooting.

5. When the default MAPISVC.INF in the Windows system folder has been updated, close all
applications which are using the Extended MAPI to reload MAPISVC.INF.

Installing PST Importer

PST Importer is installed by default when you install Metalogix Archive Manager for Exchange. If
it has not been installed, see the Metalogix Archive Manager for Exchange Advanced Installation
Guide. Look for the topic Install the Archive Server in the Advanced Installation section.

When installing the Metalogix Archive Manager for Exchange you will be prompted to select the
individual features. In the Select Features window, select the PST Importer feature and proceed
with the installation.

Archive Manager for Exchange *
Select Features ‘
Select the features setup will install. "'

Select the features you want to install, and deselect the features you do not want to install.

----- [Japplication Server B=rais

E PST Importer PST Importer imports and

[Jadministrative tools archives PST files.

151,76 MB of space required on the C drive
90514.67 MB of space available on the C drive
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Configuration

PST Importer must be configured before use to set up critical folders for operational use and
specify a default mailbox and folder for PST imports. To configure the PST importer, follow the
steps described below:

In this topic:

e Steps to open the Options window

e Folders tab
e Analyze tab
e Default tab

e Archive tab

Steps to open the Options window

1. Click Start > Programs > Metalogix > Archive Manager Exchange > PST Importer to start the
application.

# PSTImporter mER

File  Analyze Import Tools  PST Gathering  Help

Import HProcessed "Error ]

PST file name | User | Password | Destination folder | Access method |

2. From the Tools menu click Options to open the Options window and review or revise the
properties in each tab as described below.

3. Click Apply to save and continue or click OK to save and exit the Options window. Click Cancel
to exit the window without saving any changes.

Metalogix Archive Manager for Exchange PST Importer Guide
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Folders tab

The Folders tab specifies the location of the folders that are used for various operations of the
PST Importer. A default location for each folder is already specified and you can modify them as
needed.

Options %
Folders | Analyze ||Default || Archive
g_ﬂ._'l_i_—::. —

The importfolder holds the PSTfiles prepared for import.
Import folder:

|C:'|Program Files (xBG)WetalogixWAM%xdﬂange'lel EBironse

The error folder will hold PST files which were not imported,
because of an error.

Error folder:

|C:'|Program Files (xBG)WetalogixWAM%xdﬂange'lel EBironse

The processed folder will hold PST files which were not
imported, because some of it's messages are not archivable

Processedfolder:

|C:'|Program Files (xBG)WetalogixWAM*lExdﬂange'PEl Browse

Log folder:
|C:'|Program Files (xBG)WetalogixWAM*lExdﬂange'PEl Browse

[ Create a new log file for each action

e

All the folders are created by default underc:\Program Files (x86)\ Metalogix\
MAM4Exchange\PST. You may select another location by clicking the Browse button and
selecting another folder.

Import folder - Microsoft Outlook data files can reside anywhere on the computer. When opened
by PST Importer they are copied from their original location to the Import folder for further
processing. When all items from a PST file are successfully archived, then the PSTfile is deleted
from the Import folder.

Error folder - Stores the PST files which were not imported because of an import error. not all
items from a desired . The PST file is moved from the Import folder to the Error folder.

Processed folder - Stores the PST files which were not imported because one or more messages
could not be archived. The error can also happen if the option Move non-archivable messages to
mailbox is not selected in the Default tab. The PST file is moved from the Import folder to the
Processed folder.

Log folder - Stores the log files generated by PST Importer. Log files are used for recording all the
actions on PST files (e.g. analyze, report, etc.).

Create a new log file for each action - By default, all logs are written into one log file. Select this
check box to create a new log file for each action on a PSTfile (e.g. analyze, report, etc.).

Metalogix Archive Manager for Exchange PST Importer Guide
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Analyze tab

The Analyze action helps to identify a suitable owner in the destination mailbox for messages in
PST file depending on the frequency of occurrences in the sender and recipient list. The Analyze
action counts the senders and recipients from all emails in the PST file and generates a count. A
ratio is calculated for each recipient and sender by dividing the total number of occurrences of
recipients in the recipient list and senders the sender list by the sum of recipients and senders.
The ratio is displayed as a percentage. The user with the biggest ratio indicates the most suitable
destination mailbox or owner of the messages in the PST file and would therefore be
automatically assigned as the default owner.

Options 3
Folders || Analyze || Default | Archive
Q—é-_l.lljfi?: —

[ Always analyze the PST file before import

Lowest distinguishing ratio (%):

When below ratio:

(" Assign user with the highest "From" count
{” Assign user with the highest "To" count

(* Always ask

- | [w]'d | | Cancel | | Apply

Always analyze the PST file before import - Select this check box to every manually loaded PST
file is analyzed.

Lowest distinguishing ratio (%) - There could be several users with a marginal difference in the
ratios. Set this value to determine how the default owner is assigned as described below:

o |f the difference between the two highest ratios is higher than the Lowest distinguishing ratio,
then the owner is assigned tot he mailbox user with the highest ratio.

o |f the difference between the two highest ratios is lower than the Lowest distinguishing ratio
then:

o Assign to user who has the most "From" count - select this option to assign the user with the
highest "From" count as the default owner of the PST file that was analyzed.

o Assign to user who has the most "To" count - select this option to assign the user with the
highest "To" count as the default owner of the PST file that was analyzed.

Metalogix Archive Manager for Exchange PST Importer Guide
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o Always ask - you will be prompted to manually assign an owner of the PST file that was

analyzed.

1 | NOTE: If an assigned user does not exist on the Exchange server, or the assigned user exists

but has not been synchronized with Archive Manager, the default owner configured in the

Default tab will be used.

Default tab

This tab defines the default properties that are used during a PST file import when these
properties are not defined for the PST file being imported.

Options 3

Folders || Analyze | Default || Archive

ﬁ—_[.-':hn M Valres’

Ownier:

|1:imashford | Browse
Destination folder:

| | Browse

Alternate folder:

|PST

[¥ Always create the whole folder tree

[+ Move non-archivable messages to mailbox

ﬁ-—:uur_h SEChMOS

[ Clear existing list before a new search

e

Owner - the destination mailbox that will be used to load the messages from a PST file.

Destination folder - the root folder for all messages that are loaded from a PST file. If the folder
does not exist in the destination mailbox, the folder will be created.

1 | NOTE: If you intend to import more than one PST file to the same destination mailbox, you

below:

can create unique root folders for each PST file by entering the special tags described

a. %PSTNAME% - the folder name is the display name of the PST file.
b. %PSTFILENAME% - the folder name is the file name (without extension) of the PST file

For example, if Maya-2019.pst is the file name of the PST folder being imported and you
enter PST Archive/$PSTFILENAMES in the Destination folder, then a folder hierarchy
will be created under the destination mailbox root as PST Archive > Maya-2019.

Metalogix Archive Manager for Exchange PST Importer Guide
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Alternate folder - This property is required if the Destination folder is blank. If there are any
messages in the root node of PST file, then these messages will be will be imported to this
folder. If this folder does not exists in the destination mailbox, the folder will be created
automatically. All other items will be imported to the respective folders of destination mailbox
and non-existent folders will be created automatically.

Always create the whole folder tree - select this check box to create the entire tree structure of
the PSTfile in the destination mailbox including folders that are empty. When this option is not
selected, empty folders in PST file will not be created in the destination mailbox.

Move non-archivable messages to mailbox - select this check box to move all non-archivable
messages like already archived, shortcuts and undefined message classes to the destination
mailbox. If this option is not selected, the messages that cannot be archived are not moved to the
destination mailbox and the PST file is subsequently moved to the Processed folder when the
import completes.

Clear existing list before a new search - select this check box to clear the search results list in the
Gather management window every time you search for PST files. In this way the old search
results will be deleted and only the new results will be included in the list.

Archive tab

Allows you to specify the compression and retention for messages imported through PST
Importer.

Options 3
Folders || Analyze | Default || Archive
Q SO PrESSI0N OPLoNS

[ Compress MSGfiles

[ Compress attachments

—@ RELENHON OPLIonS

Retention category: <Default> ﬂ

- | a4 | | Cancel | | Apply

Compress MSG files - select this check box to compress messages when they are archived.

Compress attachments - select this check box to compress attachments when they are archived.

Retention category - select a predefined retention category from the down-drop box. If no
retention category is selected, the default retention category set in the Archive Manager will be
used.

Metalogix Archive Manager for Exchange PST Importer Guide
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Log files

Each action on a PST file is logged in one or more log files. Logs are written to a single file or
action-specific files based on the configuration settings. For more information see the Folders
tab section.

Steps to view log files
1. Open PSTImporter.

2. Click the File menu and then select View log file.

@ PSTImporter FER
File | Analyze Import Tools  PST Gathering  Help
Ca  AddPST file _]
4 FRemove PST file ser | Password | Destination folder | Access method |
(3 Refresh efault Mo default MAPI
- avidwebb fes default MAPI
I|tl View log file | mashford Mo Inbox MAPI
Close

3. The logfiles are displayed in the Log Files window. This list can be sorted by name, date or size
by clicking the respective column header.

Log Files FER
Log filelist:

File: | Date | size

& Analyse_2020126.log 12/5/2020 2:12:07FM  2.42KB

P PST_2020126.log 12/6/2020 5:52:23 AM 5,83 KB

el

4. Double-click alog file or select a log file and click Show. The contents are displayed in the
ViewLogFile window.

Metalogix Archive Manager for Exchange PST Importer Guide
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# ViewlL

= Import batch started at Sunday, December &, Z020 €:21:47 AM =

Processing file: C:wProgrem Files (xB8@)‘\Metalogix\MAM4Exchange\EST'\Import
“timashford.pst

Assigned user: 1

Bzse foldex:

Folder: Deleted Items | Messages: O

Folder: Inbox | Messages: 6031

Folder: Inbox/Fix Regquest | Messages: 1287

Creating folder in mailkbox: Inbox/Fix Reguest

Folder: Inkox/CSKE DPRM | Messages: Z35

Creating folder in mailbox: Inbox/CSE PRM

Folder: Inbox/Personal | Messages: 113

Creating folder in mailkbox: Inbox/Personzal

Folder: Inbox/S5C Wizards | Messages: O

Creating folder in mailbox: Inbox//5C Wizards

Folder: Inbox/SC Wizards/Workflow | Messages: 7193
Creating folder in mailbox: Inkox/5C Wizards/Workflow
Folder: Inbox/Template | Messages: 1

Close

Metalogix Archive Manager for Exchange PST Importer Guide
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Manual import

Manual import of Microsoft Outlook data files is a three-step process:

1. LoadingaPSTfile

2. Preparing a PST file

3. Importing a PST file

Optionally, you can review and configure each PST file with the following features:

e Viewing a PST file summary

e Analyzing a PST file

Loading a PST file

To load a PST file follow these steps:
1. Open PST Importer.
2. From the File menu click Add PST file.

@ PSTImporter EEE

m Analyze  Import  Toels  PST Gathering  Help

[Ca  AddPSTfile I
4 Remove PST file ser | Password | Destination folder | Access method |

(3} Refresh

1 View log file

Cloze

3. Inthe Open window locate the PST file and then click Open.

Metalogix Archive Manager for Exchange PST Importer Guide
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@ Open b
« v ‘ » ThisPC » Downloads v @O Search Downloads el
Organize = Mew folder Bz~ [ o
[ Desktop L Mame Date modified Type Size
* Downloads timashford.pst ~ 7/30/2020 2:33 PM Outlook Data File 631,425 KB
Documents annasmith.pst 7/30/2020 2:39 PM Outlook Data File 631,425 KB
[&] Pictures -+ davidweberpst  7/30/2020 2:39 PM Outlook Data File 631,425 KB
3 This PC
[ Desktop
Documents
* Downloads o
File name: |timashfnrd.pst V| PST files (*.pst) =

4. The file will appear on the Import tab. The PSTfile is stored in the Import folder as specified in
the Folders tab under Tools > Options.

@ PSTImporter =E e

File  Analyze Import Tools  PST Gathering  Help

Import ”Processed "Error ]

PST file name User Password | Destination folder | Access method

timashford.ps default default
@ annasmith, pst default default
@ davidweber.pst default Mo default

1 | NOTE: To successfully load the PST file, it cannot be used by another program on the
client’s computer. To remove a PST file from the list, select the file. Then right-click and
select Remove PST file from the context menu.

Preparing a PST file

When a PST file is loaded, it is automatically assigned the default owner and the default
destination folder. These defaults reference the default settings of the PST Importer.

To set a specific owner and specific destination folder for a PST file, follow the steps described
below:

1. Right-click the PST file and select Settings from the context menu or double-click the desired
PST file.

Metalogix Archive Manager for Exchange PST Importer Guide
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& PSTImporter EE R

File  Analyze Import Tools  P5T Gathering Help

Impaort HProcessed HError ]

PST file name |User | Password | Destination folder | Access method |

COERS o Add PST file T

@Iannanmi'lh.n.l:f defanlt R PET fil
@davidweber.pst default emaeve e

&

Analyze selected
@& Import selected

Change owner

Change owner to default

&' setting= |

& Info

2. Inthe PST Properties window click the Settings tab. The PST Properties window opens.
3. Specify the property values as described below:

4. Target mailbox - click Browse to open the Select mailbox window and choose the new owner
mailbox.. You can also right-click the PST files and select the Change owner from the context
menu. Click Default on the Settings tab, to revert the Target Mailbox to the default owner. You
can also right-click the PST files and select the Change owner to default from the context
menu .

PST Properties - timashford.pst
Settings | Password
mn);-.sumhi.u.s 1T TET e —

Target mailbox:
|<defau\t> || Browse I

W PST importer

Select mailbox

% Default folder (defined ondlient) Type in the name or select from list:

Target folder:

 Specificfolder |

| ‘ Browse | Display name Alias email address
Tlm Ashford timashford timashford @democorp.com
@ Pablo Meruda pabloneruda pabloneruda @demacorp.com
(2 Nina Tanaka ninatanaka ninatanaka @democorp.com
(2 Niki Portman nikiportman nikiportman @democorp. com
(2 Karl Jordan karljordan karljordan @democorp. com
I';] Juan Christie juanchristie juanchristie @democorp.com
Q Ishna Mohan ishnamahan ishnamohan@democorp. com
@ Devika Sharma devikasharma devikasharma@democorp. com
(2, David Webb davidwebb davidwebb @democorp.com
[ Aman Al amanali amanali @demaocorp.com
(3 Administrator domadmin domadmin @democorp. com

_

5. Specific folder - either type the mailbox folder name in the text box or use the Browse button
to select a mailbox folder.

Metalogix Archive Manager for Exchange PST Importer Guide
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PST Properties - timashford.pst

Settings || Password

&Jﬂxga;umﬁ.h‘s Jnd SO Er

Target mailbox:

B —

|ﬁmashford

|| Browse |

# Mailbox folders

Mailbox:

I

Target folder:
" Default folder {defined on client)

% Specificfolder

|| Browse |

|ﬁmashfurd

Mailboxfolders:

E-5) Calendar
B3 Contacts
--{C) Conversation Action Settings
--{{7) Deleted Items
) Drafts
--{C7) ExternalContacts
e
{3 Journal
{3 Junk Email
{5 Notes
{5 Outbox
{5 Quidk Step Settings
-+{C7) RSS Feeds
--{C) Sent Items
=) Sync Issues

=

v

1 | NOTE: If you intend to import more than one PST file to the same target mailbox, you
can create unique root folders for each PST file by entering the special tags described

below:

file

a. %PSTNAME% - the folder name is the display name of the PST file.

b. %PSTFILENAME% - the folder name is the file name (without extension) of the PST

For example, if Maya-2019.pst is the file name of the PST folder being imported and you
enter PST Archive/$PSTFILENAMES inthe Destination folder, then a folder hierarchy
will be created under the destination mailbox root as PST Archive > Maya-2019.

6. If the PSTfile was password protected, click the Password tab. Then enter the password in the

Password field and re-enter the password in the Confirm password field.

PST Properties - timashford.pst =

Settings || Password ]

ﬂ-’ﬁéjgmu—

here:

Password:

If the PST file is password protected, please enter the passward

|tttttttt

Confirm password:

|tttttttt

]

e

7. Click Apply to save and continue or click OK to save and exit the PST Properties window. Click

Cancel to exit the window without saving any changes.

Metalogix Archive Manager for Exchange PST Importer Guide
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Viewing a PST file summary

The PST file summary provides an overview of the PST file that includes its structure, folder size
and number of items in each folder. To view the summary follow the steps below:

1. Right-click a PST file and select Info from the context menu. If the PST file is password
protected, you must specify the password in the Password tab of the PST properties window.

@ PSTImporter FE®

File  Analyze Import Tools  PST Gathering  Help

Import HProcessed "Error ]

PST file name | User | Password | Destination folder | Access method |

@ annasmith.pst default Mo default MAPT
davidweber . pst davidwebb fes default MAPT

timashford.pst G3  Add PST file %LPSTFILENAME%. MAPT

24 Remove PST file

Analyze selected
@ Import selected

Change owner

Change owner to default

Settings
|ﬁ Info |

2. The summary info displays only the size and structure of the PST file by default.

& PST file - timashford.pst B
Summary information about the PAT file: Outlook Data File

Mumber of Folders: 16

tumber of messages: 100

Folders:

Folder Messages Size ~
[dDeleted Items 1]

mCalendar 10

|85 Contacts 20

[ Conwersation Action Settings o

[ADrafts 0 =
[ b 30

éi]ournal 10

[ Junk E-Mail i

o |Mates 10 I
(L3 outhio 1]

[ Quick Step Settings ]

[R5 Feeds i o
[ s

3. Toview the Size of the folders click Folder size.

Metalogix Archive Manager for Exchange PST Importer Guide
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& PST file - timashford.pst B

Summary infarmation about the PST File: Outlook Data File

Mumber of Folders: 16

Mumber of messages: 100 Total size: 4,67 ME

Folders:

Folder | Messages Size o~
[ Deleted Irems 0 0B

HH calendar 10 154,46 KB

&= Contacts 20 112,78 KB

[ Conversation Action Settings ] OB

[ Drafts ] 0B E

[ Inbox 30 3,93 MB

S ourmal 10 58,93 KB

[ Junk E-Mail o 0E

| Motes 10 54,47 KE I
L Outhox o 0E

[ Suick Step Settings ] 0E

[JRS5 Feeds 0 0B »

E= LTL 4 444 =y

Analyzing a PST file

To analyze a PST file follow the steps described below:

1. Right-click a PST file and select Analyze selected from the context menu. If the PST file is
password protected, you must specify the password in the Password tab of the PST properties

window.

@ PSTImporter

File  Analyze Import Tools  PST Gathering  Help

Import HProcessed "Error ]

PST file name | User | Password | Destination folder | Access method |
@annamim.pst default Mo default MAPT
3 davidweber pst davidwebb Yes default MAPT

@ AP

g Remove PST file

| Analyze selected |

@ Import selected

Change owner

Change owner to default

Info

Settings
aQ

-or-

Select the PSTfile. Then click Analyze from the menu and select Analyze selected.

Metalogix Archive Manager for Exchange PST Importer Guide
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@ PSTImporter =E e

File | Analyze | Import Tools  PST Gathering  Help

Import] Analyze all

PST fil | Analyze selected | | Password | Destination folder | Access method |
@ annasmith. pst default No default MAPT
@davidweber.pst davidwebb Yes default MAPT

timashford.ps timashford SPSTFILENAME®: MAPL

1 | NOTE: To analyze all PST files at once, select Analyze all.

2. The Analyzer progress window opens and displays the progress of the analysis of one or more
PST files.

3. When the analysis completes, the Result of analysis window displays the results.

& Result of analysis

Assign PST file owners
PST files: Users
PST file | Selected user | User | From count | To count | Ratio | ~
ﬁ].ﬁrnashﬁ::rd.pst unknown * Sloan Scott 24 74 13
98 Unland Melinda g 3 &
[ﬁnikiporhﬂan@democorp.com 13 22 4
(2 davidwebb @democorp. com 1 25 3
Tim Ashford 0 24 3
[ﬁninamnaka@democorp.com 6 23 3
[ﬁkarljordan@democorp.mm a 28 3
[ﬁjuanﬁrisﬁe@demomrp.mm a 22 2
[ﬁishnamohan@demomrp.com 0 22 2
[ devikasharma@democarp. com 0 15 2
@amanali@demomrp.mm 0 21 2
B 1affari zaina 0 0 2
* Baranova Sharrmila 0 20 2
28 Rickerby Quentin 0 13 2
v
— E——

4. The left-hand side of the window lists the PST files. If a valid owner could not be determined
from the results of the analysis, the currently assigned user is set to unknown. When you click
on a PSTfile, the right-hand side displays the list of senders and recipients. If no user has be
assigned as the owner of the PST file, double-click the user you want to select or select the
user and click Assign.

5. When the PST files are ready, click Close to close the window. All PST files will be saved with
the changes.

6. When the owneris assigned either automatically or manually, the new settings will be
displayed on the Import tab.
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# PSTImporter =E R

File  Analyze Import Tools  PST Gathering Help

Import | Processed || Error

PST file name | User | Password | Destination folder | Access method |
@ annasmith. pst default No default MAPT
@davidweber.pst davidwebb Yes default MAPT

timashford YPSTFILENAME®:  MAPI

Analysis Results

1.

Users displayed with the red cross icon (%) are considered invalid users because they do not
exist on the Exchange server or have not been synchronized with the Archive Manager server.
You cannot assign the default user of PST file to invalid users.

Analysis results are based on the settings in the Analyze tab of the PST Importer configuration
options.

If the PST file has a single user, a 100% ratio is attained as the outcome of the analysis. The
user is assigned automatically as the owner of the PSTfile if the useris a valid user. If the user
is invalid, the Assign button remains inactive and the default owner configured on the PST file
will be used.

If there are two or more valid users and the difference between the two highest ratios is
higher than the Lowest distinguishing ratio, then the valid user with the highest ratio is
assigned automatically as the owner of the PST file.

If there are two or more valid users and the difference between the two highest ratios is
lower than the Lowest distinguishing ratio, then:

a. If the Assign user who has the most "From" count option is selected then the user with the
highest "From" count is assigned automatically. If the "From" count is identical for several
users then the user with the highest ratio is assigned automatically.

b. If the Assign user who has the most "To" count option is selected then the user with the
highest "To" count is assigned automatically. If the "To" count is identical for several users
then the user with the highest ratio is assigned automatically.

If the Always ask option is selected then you will be asked to select the owner.
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Importing a PST file

To import one or more PST files follow the steps described below:

1. Right-click the selected file and then select Import selected from the context menu.

@ PSTImporter FE®

File  Analyze Import Tools  PST Gathering  Help

Import HProcessed "Error ]

PST file name | User | Password | Destination folder | Access method |
@annamim.pst default Mo default MAPT
davidweber . pst davidwebb fes default MAPT

SoPSTFILEMAMES  MAPT

Ca  AddPST file
©4 Remove PST file

Analyze selected
|ﬁ Import selected |

Change owner

Change owner to default

Settings
aQ

Info

-or-

Select the PST file. Then click Import from the menu and select Import selected.

@ PSTImporter FEE

timashford

YoPSTFILENAME %%

File  Analyze | Import | Tools  PST Gathering  Help
Import | Process @ Importall

PST file name |ﬁ Import selected | Password | Destination folder | Access method |
@ annasmith. pst default No default MAPT
@davidweber.pst davidwebb Yes default MAPT

MAPT

1 ‘ NOTE: To import all PST files at once, select Import all.

2. When the PST file import process completes, a Status message box appears. Select OK to close
the Status message box.

Status =

Processing of selected PSTfiles finished.
Total PST files: 1

Successful: 1

Failed: 0

Depending on the import status, the following actions occur:

a. If the import was successful and all items including non-archivable items were imported,
the PST file is removed from the Import tab and deleted from the Import folder.
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b. If the import was partially successful and one or more non-archivable items could not be
imported, the PST file is moved to the Processed tab and the physical file is moved from
the Import folder to the Processed folder.

c. If the import failed and one or more items could not be imported due to an error, the PST
file is moved to the Error tab and the physical file is moved from the Import folder to the
Error folder.

Itis recommended that you check the log file after import. See Log files for more information.

Managing PST files with import problems

PST files can be moved from the Error tab or Processed tab back to the Import tab to modify their
settings and retry the import. To move a PST file:

1. Right-click the PST file displayed in the Error tab or the Processed tab.

2. From context menu, select Move to import. The file will be moved back to the Import tab.

@ PSTImporter =ER

File  &nalyze Import  Tools  PST Gathering  Help

Irnpaort Processed Errar

P=T file name | Liser | Password |

useronz

Rernowve

e o import [:

Settings

3. When a PST file is moved back to the Import tab, the physical file is moved to the Import
folder. Messages that were successfully imported are removed from the file. As a result, PST
Importer will attempt to import the remaining messages.

1 | NOTE: If the import fails and the user reloads the original PST file, then duplicate emails
will be imported —those from the first import and those from the second import.
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6

Automated import

Automated import uses a complementary application called PST Gatherer to collect PST files from
client computers. These files are then automatically uploaded to the PST Importer server where
they can be manually imported and archived. Automated import is recommended for large
organizations so that the manual process of collecting and uploading PST files from client

computers is automated.

1. When PST Gathereris installed as an application or a service on the client computer, it
searches through local and network drives as permitted and uploads the PST file to the

specified PST Importer server.

2. When aclient computer is registered in the PST Importer server, a sub-folder for each client

computer is created in the C:\Program Files (x86)\Metalogix\MAM4Exchange\PSTs folder.

Each PST file that is uploaded from the client computer will be stored in a unique sub-folderin

the client computer folder.

& C:\Program Files'MAM'PSTs' ¥MXDEMO =101 =]
File Edit ‘iew Favorites Tools Help | #
oack ~ 3 - (T | ) Search [ Folders | & [ X 6 | -
Address I (2 C\Program Files\MetalogixMaMdexchange|\PST= WMEDEMO j Go
Mame = | Size | Tvpe | Dake Modified | Attributes | -
[CHUNZE749635TM | File: Folder 10262005 5:09 FM
) UNZE775672TM File Folder 10/26/2005 5:09 PM
C)UNZ2E40571TM File Folder 10/26/2005 5:09 PM —
C)UNST257942TM File Folder 10/26/2005 5:09 PM
CUNFA246122TM File Folder 10/26/2005 5:10 PM
I UNT 353983954 TM File Folder 10/26/2005 3:07 PM
ICIUN1 35464541 TM File Folder 10/26/2005 3:05 PM
ICIUN1B5734576TM File Folder 10/26/2005 5:09 PM
ICIUN195785557TM File Folder 10/26/2005 5:10 PM
I UNZEE064554TM File Folder 10/26/2005 5:09 PM
ICIUNS52574521TM File Folder 10/26/2005 5:09 PM
L UNZ96109709TM File Folder 10/26/2005 5:09 PM LI
R IR AT AT A AT Lo I o N P Am o bemnr Coam nea

|53 objects |D bevkes | J Tl Computer S

3. The administrator uses the PST Import wizard to import the PST files stored on the server

computer from C:\Program Files (x86)\Metalogix\MAM4Exchange\PSTs\<client-
computer-name> to their destination mailboxes and destination folders and subsequently

archives the email items.

Requirements

1. PST Gatherer must be installed on all client computers from where PST files are gathered.

2. Firewall permissions must be granted to the PST Gatherer that is installed on the client

computers.
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3. The PST Gatherer application or service must be started.

4. The client computer must be registered in the PST Importer server.

Install PST Gatherer

In this topic:

e Steps to manually install PST Gatherer

e Steps to automatically install PST Gatherer

e Steps to verify the PST Gatherer installation as an application

e Steps to verify the PST Gatherer installation as a service

e Configuring PST Gatherer to communicate through a firewall

e Steps to repair the PST Gatherer installation

e Steps to remove the application or service

Steps to manually install PST Gatherer

1. Double-click <install-media-folder>\Metalogix\Archive Manager Installation
Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe

ﬂ Archive Manager P5T Gatherer - InstallShield Wizard >

Welcome to the Installshield Wizard for
Archive Manager PST Gatherer

The InstallShield(R) Wizard will install Archive Manager PST
Gatherer on your computer. To continue, dick Mext,

WARNIMG: This program is praotected by copyright law and
international treaties.

2. Click Next. The License Agreement window opens. Select | accept the terms in the license
agreement.
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ﬁ Archive Manager PST Gatherer - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

Software Transaction Agreement ~

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY
DOWNLOADING, INSTALLING OR USING THIS PRODUCT, YOU ACCEPT AND AGREE TO
THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR ORDERS PLACED OUTSIDE
THE UNITED STATES OF AMERICA, PLEASE GO TO httpiifquest.comilegalista.aspx TO
WIEW THE APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION. IF YOU DO
NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT OR THE
APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION, DO NOT DOWNLOAD,
INSTALL OR USE THIS PRODUCT. IF YOU HAVE A SIGNED AGREEMENT WITH PROVIDER
THAT 15 SPECIFICALLY REFERENCED IN AN ORDER THAT 15 EXECUTED BETWEEN YOU

AND PROVIDER. THEN THAT SIGNED AGREEMENT WILL SUPERSEDE THIS AGREEMENT. ¥

(@)1 accept the terms in the license agreement Print

()1 do not accept the terme in the license agreement

Installshield

3. Click Next. The Destination Folder window opens. Keep the default or click Change to select
another installation location.

ﬁ Archive Manager PST Gatherer - InstallShield Wizard X

Destination Folder
Click Mext to install to this folder, or dick Change to install to a different folder.

Install Archive Manager PST Gatherer to:
C:\Program Files (x36)\Metalogix\MAMAExchange \PSTGatherer), Change. ..

InstallShield

4. Click Next. The Install Types window opens.
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ﬁ Archive Manager PST Gatherer - InstallShield Wizard X

Install Types

Install PSTiGatherer as an application or as a service

PsTGatherer installation type:

(®) Application
Select this option to run PSTGatherer as an application

Autostart
Select this option to start the application when the user logs on

Show in tray
Select this option to display a tray icon for the application

() Service
Select this option to run PSTGatherer as a service

Installshield

5. Select an option to install PST Gatherer either as a service or an application as described
below:

a. Application - Users keep PST files not only on local drives, but also on the network shares
and selecting this option allows PST Gatherer to search and gather PST files from the local
drives and network shares where the current user has access rights.

b. Autostart - when selected, the PST Gatherer application will start whenever the user logs
on.

¢. Show in tray - when checked, a tray icon for this application will be displayed.

d. Service - selecting this option ensures that PST Gatherer runs as LOCAL SYSTEM which has
limited rights to search files on the local drives only.

6. Click Next. The Configuration window opens.
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ﬁ Archive Manager PST Gatherer - InstallShield Wizard

Configuration

Server settings and search conditions

Server settings

PST Import Server name:

AMRSERVER. Browse

Search conditions;

Allowed drive list:

Blocked drive list:

A

Allow to search network drives on the dient

Installshield

7. Enterthe information as described below:

a. PSTImporter server name - enter the name or click Browse to locate the Archive Manager
server.

b. Allowed drive list - Enter one or more drive letters that can be searched for PST files.
Separate the letters with the pipe (|) character. You can enter an asterisk (*) to indicate all
drives.

c. Blocked drive list - Enter the drive letters that can be searched for PST files. Separate the
letters with the pipe (|) character. For example A|B will prevent floppy drives A and B
from being searched.

d. Allow to search network drives on the client - select this check box to permit PSTGatherer
to search the specified network drives.

8. Click Next. The Ready to Install the Program window opens.
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ﬂ Archive Manager PST Gatherer - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield

| < Back |E Install { | Cancel |

9. Click Install. When the installation completes, the InstallShield Wizard Complete window
opens.

ﬂ Archive Manager PST Gatherer - InstallShield Wizard X

InstallShield Wizard Completed

The Installshield Wizard has successfully installed Archive
Manager P5T Gatherer, Click Finish to exit the wizard.

[ ] show the Windows Installer log

10. Click Finish to complete the installation.
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Steps to automatically install PST Gatherer

Setup is available in two options:

e MSI Setup

o EXE Setup

You can create a silent setup with custom property values and the command option /qn

MSI Setup
Installer file location

<install-media-folder>\Metalogix\Archive Manager Installation
Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.msi

Syntax

msiexec /[option] [msi installer file location] PROPERTY=VALUE
PROPERTY2=VALUE PROPERTY3=VALUE....

Property values that are literal strings must be enclosed in quotation marks.
spaces can be included in the string between the marks.

msiexec /[option] [msi nstaller file location] PROPERTY="Embedded White
Space"

Examples

Action Command

First install msiexec /i [msi installer file location]
or
msiexec /i [msi installer file location]
PSTSERVER="AMXSERVER"

Repa” msiexec /1 [msi installer file location]
REINSTALL=ALL REINSTALLMODE=vomus

Change import server name msiexec /i [msi installer file location]
REINSTALL=ALL REINSTALLMODE=vomus
PSTSERVER="AMXSERVER"

Logging msiexec /i [msi installer file location] /l*v
[path to PSTGathererlLog.txt file]

Uninstall msiexec /x [msi installer file location]

Silent mode msiexec /i [msi installer file location]

PSTSERVER="AMXSERVER" /qgn
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1 | NOTE: For more information related to msiexec command-line options see
http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/msi/setup/command line options.asp

EXE Setup
Installer file location

<install-media-folder>\Metalogix\Archive Manager Installation
Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe

Syntax

[exe installer file location] /v"PROPERTY=VALUE PROPERTY2=VALUE
PROPERTY3=VALUE"

Property values that are literal strings must be enclosed in quotation marks. White spaces can be
included in the string between the marks.

[exe installer file location] /v"PROPERTY="Embedded White Space"

Command-line options that require a parameter must be specified with no space between the
option and its parameter. For example, PST Gatherer

Setup.exe /vV"PSTSERVER=testdemo" isvalid, whereas PST Gatherer Setup.exe /v
"PSTSERVER=testdemo" is not. Quotation marks around an option's parameter are required
only if the parameter contains spaces.

If a path within a parameter contains spaces, you may need to use quotation marks within

guotation marks, as in the following example: PST Gatherer
Setup.exe /v"INSTALLDIR=\"C:\My PST Files\""

Examples

Action Command

First install [exe installer file
location] /v"PSTSERVER="AMXSERVER""

Repan [exe installer file location] /v"REINSTALL=ALL
REINSTALLMODE=vomus"

Change import server name [exe installer file location] /v"REINSTALL=ALL
REINSTALLMODE=vomus PSTSERVER="AMXSERVER""

Logging [exe installer file location] /v"/1*v \"C:\My
logs\PSTGathererLog.txt""

Uninstall [exe installer file location] /v"/x"

Silent mode [exe installer file

location] /v"PROPERTY="value" ... /gn"
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Properties

Itis possible to change the default registry and config key values and set your desired values with
PSTGatherer command line options. If no PSTGatherer cmd option is specified, default values will
be used. Specifying values with properies is needed only in for silent installation.

Property

INSTALLDIR

INSTALLTYPE

GATHERERID

Value

[ProgramFilesFol
der]
\Metalogix\MAM4E
xchange\PSTGathe
rer

1- (default)
PSTGathereris
installed as an
application

2 - PSTGathereris
installed as a service

O-noiconis
displayed on the
taskbar

1- (default) shows
the icon on the
taskbar

Description

Path to the
installation directory

Indicates the type of
installation for the
PSTGatherer

Indicates whether or
not anicon tray
should be displayed
on the taskbar.

Note

Use only
with first install if
you wish to change
the default location.

Use only
with first install.
Once PSTGatherer is
installed as an
application, it cannot
be changedto a
service. If you want
to change itto
service, you have to
uninstall it and then
install it again with
new settings.

NOTE: Can be used
only if PSTGatherer
isinstalled as an
application with
INSTALLTYPE="1"

If PSTGatherer is installed
as an application
(INSTALLTYPE="1") then
the setup program creates
the GATHERERID registry
key of type REG_DWORD at
the following location:

HKEY LOCAL MACHINE\SO
FTWARE\Wow6432Node\Me
talogix\PAM4Exchange\
PAMGatherer
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AUTOSTART 0- removes the Indicates whether or | If PSTGatherer is installed

PSTGatherer not the PSTGatherer | as an application
application from should start when (INSTALLTYPE="1") then
Start/Programs/Start | the userlogsin to the setup program creates
up the computer. the AUTOSTART registry

key of type REG_DWORD at

1- (default) adds the the following location:

PSTGatherer
application under HKEY LOCAL MACHINE\SO
Start/Programs/Start FTWARE\Wow6432Node\Me
up talogix\PAM4Exchange\
PAMGatherer
PSTSERVER Localhost NETBIOS name of Use only
the PST Importer with first install if
server. Must be used the PST Importer
with This name is serveris not the
written to the Tl
configuration file.
SEARCHNETWORKDR | 0 - (default) Permits or denies
IVES PSTGatherer is not PSTGatherer to
allowed to search search the specified
network drives on network drives.
the given computer
1- PSTGathereris
allowed to search
network drives on
the given computer;
if this is the case,
specify which drives
are allowed and
which are
deactivated with the
ALLOWEDDRIVES
and
DEACTIVATEDDRIVES
properties.
ALLOWEDDRIVES * (default) Indicates drives that | Used only if

can be searched for | SEARCHNETWORKDRIVES-"
PST files. Separate 1"

the letters with the

pipe (|) character.

You can enteran



DEACTIVATEDDRIVES | A (default)

asterisk (*) to
indicate all drives.

Indicates drives that | Used only if

can be searched for | SEARCHNETWORKDRIVES-"
PST files. Separate 1"

the letters with the

pipe (|) character.

Forexample A|B

will prevent floppy

drives A and B from

being searched.

Besides the registry keys mentioned above, configuration keys in PSTGatherer config file can be
specified through properties. By default, the PSTGatherer configuration file is present at the

following locations:

o |f PSTGatherer is installed as an application

[InstallDirectoryPath]\Application\exchangePAMGatherer.exe.config

e |f PSTGatherer is installed as an service

[InstallDirectoryPath]\Service\PAMPSTGathererSV.exe.config

Configuration keys

Key Default value
CLIENTPORT 4446

CLIENTNAME <ComputerName>
CLIENTPROTOCOL tcp
CLIENTMACHINE <ComputerName>
SERVERPORT 9910

Description

Port used on the
client

Local computer name

Protocol used on the
client

Local computer name

Port used on the PST
server

Note

Do not change.

Do not change. Itis
automatically
detected and filled in
by the setup.

Do not change.

Do not change. Itis
automatically
detected and filled in
by the setup.

Do not change.
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SERVERPROTOCOL tcp

SERVERNAME localhost

SEARCHNETWORKDRI | 0
VES

ALLOWEDDRIVES *

DEACTIVATEDDRIVES | A

Protocol used on the | Must be the same as
PST Importer server on the PST Importer
server.

PST Importer server This value must be the
name NetBIOS name of the
PST Importer server.

0 - PSTGatherer is not
allowed to search
network drives on the
given computer

1- PSTGathereris
allowed to search
network drives on the
given computer; if this
is the case, specify
which drives are
allowed and which are
deactivated with the
ALLOWEDDRIVES and
DEACTIVATEDDRIVES
properties.

Enter one or more
drive letters that can
be searched for PST
files. Separate the
letters with the pipe
(]) character. You can
enter an asterisk (*) to
indicate all drives.

Used only if
SEARCHNETWORKDRI
VEs_lllll

Enter the drive letters
that can be searched
for PST files. Separate
the letters with the
pipe (|) character. For
example A|B will
prevent floppy drives
A and B from being
searched.



Used only if
SEARCHNETWORKDRI
VES_IIlII

Steps to very the installation of PST Gatherer as an application

If the PST Gatherer is installed as an application and you have selected the Show in tray check box
during installation, then a tray icon will appear. Double-click it to open the Gatherer status
window with the Gatherer status and path to PST files.

() Gatherer status window | = 0| X |
Status:
Mext search: Mext upload:

Ilzer Path

[o=First Organizationfou,.,  Carchive\Personall . psk

[o=First Organizationfou..,  CArchive_protected,pst

Refresh Close

Steps to very the installation of PST Gatherer as a service
After installing the PST Gatherer service on client computers make sure it is started.

1. Click Start >Programs > Administrative tools > Services and verify that Status =Running for
MAM PST Gatherer.
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S Services
File Action View Help

e EEC2 HEl > o0

“. Services (Local) ' Semvices (Local)
MAM PST Gatherer Mame Description Status Startup Type Log ™
5 n »f,',');KtmRm for Distributed Tran... Coordinates... Manual (Trig... Neb
top the service & . . .
Restart the service LIJ,.L.anguage Experlences.emce Provides inf... Manual Loci
& Link-Layer Topology Discov. Createsa M. Manual Loci
Q;Luca\ Profile Assistant Service  This service ... Manual (Trig.. Loci

Description:

X X Local Session Manager Core Windo.. Running  Automatic Loci
Searches for pst files and copies

them to an Archive Manager server MAM PST Gatherer Searches for.. Running Autematic
& MessagingService_16cdad Service sup.. Manual (Trig.. Loci
Q;MessagingSer\rice_?eEZBZ Service sup.. Manual (Trig... Loci
J,");Mi(rosof't(R] Diagnestics H... Diagnostics ... Manual Loci
Q;Microsof‘tAchuntSign-in... Enables use... Manual (Trig.. Loci
Q;Mi(rosoftApp-\u‘ Client Manages A.. Disabled Loci
J,");Mi(rosof'tiSCSl Initiator Ser... Manages In... Manual Loci
Q;Microsof‘t Office Click-to-R... Managesre.. Running Automatic Loci
Q;Mi(rosoft Passport Provides pr..  Running  Manual (Trig.. Lo
J,");Mi(rosof'tPasspor‘tContainer Manages le.. Running  Manual (Trig... Lec
Q;Microsof‘t Software Shadow... Manages so... Manual Loci
1€k Microsoft Storage Spaces S... Host service... Manual Neb ¥
< >

\ Extended AStandard/

2. Also check if the Importer service is started on the PST Importer Server computer, by checking

the status of MAM PST Importer service.

1 | NOTE: Restart the PSTGatherer service whenever it is updated or modified. To restart the

service, select MAM PST Gatherer and then click on the Restart Service icon on the toolbar.

Steps to allow PST Gatherer to communicate through a firewall on a
Windows 10 computer

1. Navigate to Control Panel > System and Security > Windows Defender Firewall.

0 Windows Defender Firewall — ] b
« v A @ > Control Panel » System and Security > Windows Defender Firewall v O o

Control Panel Home Help protect your PC with Windows Defender Firewall
Windows Defender Firewall can help prevent hackers or malicious software from gaining access to your PC
Allow an app or feature through the Internet or a network,
through Windows Defender
Firewall
Update your Firewall settings
E; Change notification settings
X Windows Defender Firewall is not using the
& Tumn Windows Defender recommended settings to protect your computer.
Firewall on or off

GUSE recommended settings

What are the recommended settings?

E; Restore defaults

2. Click the Allow a program or feature through Windows Firewall. The Allowed Programs
window opens.

3. Click Allow another program. The Add an App window opens.

4. Click Browse to locate the C:\Program Files (x86)
\Metalogix\MAM4Exchange\PSTGatherer\Service\PAMPSTGathererSv.exe file.

5. Select PAMPSTGathererSv.exe and click Open.
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ﬂ Browse
1 <« P§TGatherer » Service

Organize = Mew folder

~

D Music () Name

m Videos [2z] PAMPSTGathererSv.exe

@ OneDrive

[ This PC
_J 2D Objects
[ Desktop
@ Documents
4 Downloads v £

x
v & Search Service 2
- T @
Date modified Type
12/2/2020 8:34 PM Application

File name: | PAMPSTGathererSv.exe

v| Applications (".exe™.com™icd) ~

Add an app d
Select the app you want to add, or dick Browse to find one that is not
listed, and then dick OK.
Apps:
[EE|PAMPSTGatherersy
Path: | C:\Program Files (x86)\Metalogix\MAM4Exchz| | Browse...
What are the risks of unblodking an app?
You can choose which network types to add this app to.
Metwork types... Cancel

Select the PAMPSTGathererSv and the Remote Assistance check boxes.

Verify that the PAMPSTGathererSv appears in the Apps list and then click Add.
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@ Allowed apps - m} x

&~ v 4 ‘« Windows D... » Allowed apps v | O »p

Allow apps to communicate through Windows Defender Firewall
To add, change, or remove allowed apps and ports, click Change settings,

What are the risks of allowing an app to communicate? GChaﬂge settings

Allowed apps and features:

Name Domain  Private  Public *
OneNote for Windows 10
Paint 3D

| M PAMPSTGatherersv O o |
O Performance Logs and Alerts O O O
Print 3D
[ Proximity Sharing
Recommended Troubleshooting

| Remote Assistance | I
Remote Desktop
[ Remote Desktop (WebSocket) O O O
[ Remote Event Log Management O O O
[ Remote Event Monitor O O o v

Remove
Allow another app...

Garc

8. Click OK to save and exit the window.

Steps to repair the PST Gatherer installation

1. Double-click <install-media-folder>\Metalogix\Archive Manager Installation

Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe

ﬂ Archive Manager PST Gatherer - InstallShield Wizard d

Welcome to the InstallShield Wizard for
Archive Manager PST Gatherer

The InstallShigld(R) Wizard will allow you to modify, repair, or
remave Archive Manager PST Gatherer, To continue, dick
Mext,

2. Click Next. The Program Maintenance window opens.
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ﬂ Archive Manager PST Gatherer - InstallShield Wizard

Program Maintenance

Repair, or remove the program.

@ Repair

Repair installation errors in the program. This option fixes missing or
corrupt files, shortouts, and registry entries.

O Remove

@ Remove Archive Manager PST Gatherer from your computer.

Installshield

| <pack [ Next> | Cancel

3. Click Next. The Configuration window opens.

ﬂ Archive Manager PST Gatherer - InstallShield Wizard

Configuration

Server settings and search conditions

Server settings
PST Import Server name:

Browse

AMXSERVER

Search conditions:

Allowed drive list:
|=

Blocked drive list:

a
Allow to search netwaork drives on the dient

Installshield

| <Back | Next> [ Cancel

4. Click Next. The Ready to Install the Program window opens.
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ﬂ Archive Manager PST Gatherer - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

exit the wizard.

Installshield

If you want to review or change any of your installation settings, dick Back. Click Cancel to

| < Back

Install

i | Cancel

Click Install. The InstallShield Wizard Completed window opens.

ﬂ Archive Manager PST Gatherer - InstallShield Wizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Archive
Manager PST Gatherer, Click Finish to exit the wizard.

[ show the Windows Installer log

*
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Steps to remove the application or service

1. Double-click <install-media-folder>\Metalogix\Archive Manager Installation
Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe

ﬁ Archive Manager PST Gatherer - InstallShield Wizard >

Program Maintenance

Repair, or remove the program.

Repair installation errors in the program. This option fixes missing or
corrupt files, shortcuts, and reqistry entries.

@ Remove Archive Manager PST Gatherer from your computer.

Installshield

2. Click Next. The Remove the Program window opens.

ﬁ Archive Manager PST Gatherer - InstallShield Wizard >

Remove the Program

You have chosen to remove the program from your system,

Click Remove to remove Archive Manager PST Gatherer from your computer. After
removal, this program will no longer be available for use.

If you want to review or change any settings, dick Back.

Installshield

3. Click Remove. The InstallShield Wizard Completed window opens.
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ﬂ Archive Manager PST Gatherer - InstallShield Wizard d

InstallShield Wizard Completed

The InstallShield Wizard has successfully uninstalled Archive
Manager PST Gatherer, Click Finish to exit the wizard.

[ show the Windows Installer log

4., Click Finish.

Setup PST Gathering

Default values must be set for all client computers where PST files will be gathered. All default
settings, such as default destination mailbox, default destination folder, start search time and
duration, start upload time and duration must be defined because these settings are inherited by
all client computers. Once defined they may be changed for any client computer as required.

In this topic:

e Steps to open the default settings window

e Steps to configure default ownership settings

e Steps to configure default search settings

e Steps to configure default upload settings

Steps to open the default settings window

1. From the PST Importer menu click PST Gathering and then click Clients and PST files.
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# PSTImporter =E R

File  Analyze Import  Tools | PST Gathering | Help

Import " Processed " Error ] |a Clients and P5T files

PST file name | User | Password | Destination folder | Access method |
@ annasmith.pst default Mo default MAPI
@davidweber.pst davidwebb Yes default MAPI
@timashﬁ:rd pst timashford Mo %GPSTFILEMAM,..  MAPI

2. Inthe Gatherer management window click Clients from the menu and then click Default
settings.

3 Gatherer management = e e

Clients | PST

Add new client

Irmport clients

Q Files:

Delete clients
user | Destination PST File Mamne | User Password | Destination Fol

Client praperties

o Roaw

Refresh

Default settings |

2

Autormatic registrations

Close

<| m >

3. Inthe Default Client Properties window specify the defaults in the Ownership, Search, and
Upload tabs as described below.

Steps to configure default ownership settings
1. Click the Ownership tab.
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Client Properties - AMXWIN10 B

Ownership HSearch HUpIoad]

%Mumhi.u.. ——

™ Detect user fromfolder path

% Assignuser

|Admiﬁistrator | | Zhange

&'—*‘—" 15 ———
Destination Folder:

|%PSTFILENAME% | Browse

| ok || cancel || acoy |

2. Specify the default values as described below:

Assigned mailbox

a. Detect user from folder path - this setting is used for specific client computers. It remains

deactivated for default settings. See Modify client properties for more details.

b. Assign user - Click Change to open the Select mailbox window and choose a default user for
PST import. Typically this is the administrator.

T PST importer

Select mailbox

Type in the name or select from list:
Display name | Alias | email address |
[, Tim Ashford timashford timashford @democorp, com
(2 Pablo Neruda pabloneruda pabloneruda @democorp.com
[ Nina Tanaka ninatanaka ninatanaka @democorp.com
f_::‘[Nild Fortman nikiportman nikiportman @democorp. com
[21 Karl Jordan karljordan karljordan @democorp. com
Ii:-_flluan Christie juanchristie juanchristie @democorp. com
(2, 1shna Mohan ishnamahan ishnamohan@democorp. com
(2 Devika Sharma devikasharma devikasharma@democorp.com
[ David Webb davidwebb davidwebb @democarp.com
I';:‘_fl Aman Ali amanali amanali@democorp.com
@ Administrator domadmin domadmin @democorp. com
< >

_

Options

a. Destination folder - the root folder for all messages that are loaded from a PST file. If the

folder does not exist in the destination mailbox, the folder will be created.
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# Mailbox folders =

Mailbox:

|Administrator

Mailboxfolders:

H-CT) Calendar

M5 Contacts

{7y Conversation Action Settings
H-{C5) Deleted Items
{7 Drafts

{7 ExternalContacts
- Inbox

- Journal

4T Junk Email

Ty Motes

{7y Qutbox

-7 Quick Step Settings
-7y RSS Feeds

-|[3) Sent Items

H-IC3) Sync Issues

[o]9

Zancel

PST file

2019.

NOTE: If you intend to import more than one PST file to the same destination
mailbox, you can create unique root folders for each PST file by entering the special
tags described below:

a. %PSTNAME% - the folder name is the display name of the PST file.

b. %PSTFILENAME% - the folder name is the file name (without extension) of the

For example, if Maya-2019.pst is the file name of the PST folder being imported and
you enter PST Archive/$PSTFILENAMES in the Destination folder, then a folder
hierarchy will be created under the destination mailbox root as PST Archive > Maya-

3. Click OK to save the settings and close the window or click Apply to save and continue.

Steps to configure default search settings

1. Click the Search tab.
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Default client properties >3

- | QK || Cancel || Apply |

Ownership | Search | Upload

'ﬁ—;':lu'_ia LIME SEThng s —
Search start time: 30.06,2021 00:00 ==
Search duration {minutes):

Interval {days):

i:_:':lu"_ia Oprions

[ Search PST files on the client computer
[+ Search PST files on the client computer Outlook profiles

[~ Search and upload after logon

2. Specify the default values as described below:

Search time settings

d.

C.

Search start time - set the date and time in the format formatis DD:MM: YYYY : hh :mm when
the PST Gatherer should start searching for PST files. To change the values, select the date,
month, year or time and then use the up or down buttons to increase or decrease the
value.

. Search duration (minutes) - set the desired period in minutes. Consider a longer time

period for client computers where many PST files may reside because searching may take
time. For example, if the set of folders is limited to a 1000 folders, set the duration to 5
minutes. If the set of folders exceeds 100,000, set a duration of 15-30 minutes.

Interval (days) - set the search frequency in days.

Search options

a.

b.

C.

Search PST files on the client computer - select this check box to search for PST files in local
drives and network shares.

Search PST files on the client computer Outlook profiles - select this check box to search
through all Outlook profiles for PST files.

Search and upload after logon - select this check box to search for PST files immediately
after a userlogs in. PST files will be uploaded immediately after search.

NOTE: Search and upload will also be started at the time specified in the Search and
Upload tabs. However, if the computer is turned off or not connected to the network at
that time, no search or upload can be performed. If the above mentioned options are
checked, the client will be searched when available.
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3. Click OKto save the settings and close the window or click Apply to save and continue.

Steps to configure default upload settings
1. Click the Upload tab.

Default client properties >3
Ownership || Search || Upload

ﬁ—b’p.‘l_.ul_. LIME SEthng s e

Upload starttime: 23.06,2021 00:00 =+
Duration of upload {minutes): 30

Interval (days):

ﬁ—b’p.'l_.ul_. Oprions

r Delete PST file from client computer after it is uploaded
to the server

| b

r Remave the PST file from the OQutlook profile after it is
uploaded to the server

¥ Lock PST file on the dlient computer during upload

e

2. Specify the default values as described below:

Upload time settings

a. Upload start time - set the date and time in the format formatis DD:MM: YYYY:hh:mm
when the PST Gatherer should start uploading the PST files. To change the values, select
the date, month, year or time and then use the up or down buttons to increase or decrease
the value.

b. Duration of upload (minutes) - set the desired upload period in minutes. Consider a longer
time period for client computers where many PST files may reside because uploading may
take time.

c. Interval (days) - set the upload frequency in days.

1 | NOTE: If uploading starts before searching begins, PST files gathered during the
previous search are uploaded.

Upload options

a. Delete PST file from client computer after it is uploaded to the server - select this check
box to delete the PST files on the client computer after they are uploaded to the PST
Importer server. Selecting this option ensures that no PST file is imported twice. No PST
files will be lost because they will be moved to the PST Importer server and if the
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importing process is not completed, the file is not removed from the PST Importer server
either.

b. Remove the PST file from the Outlook profile after it is uploaded to the server - select this
check box to remove the PST file from the Outlook profile after being uploaded to the PST
Importer server.

c. Lock PST file on the client computer during upload - select this check box to lock the PST
files so that no other applications can use the files while they are being uploaded.

3. Click OK to save the settings and close the window or click Apply to save and continue.

Manage client computers

Client computers can be added to the Clients list in three different ways:

e manually one-by-one. See Add a new client.

e by automatic registration. See Register new clients.

e by importing with a comma separated file. See Import new clients.

Other client management topics:

e Remove aclient

e Modify client properties

e Deactivate aclient

Add a new client

To add a new client computer manually:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.

2. Click on the Add New Client icon on the toolbar, or from the main menu click Clients and then
select Add new client.

2 Gatherer management

Clients  PET
Cormputer name | Skaktus Assigned user Destination
@ 404002 Onilire: Administrator  PST

3. Inthe Add new client computer window enter NETBIOS name or the IP address of the client
computer.
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— Mew Client

23 Add new client computer

Enter the METBIOS name of the client computer:

Cance| |

4. Click OK. The computer will be displayed in the Clients list.

1 | NOTE: If the client computer cannot be added, the Status column of the Clients list displays

C.

Client computer is turned off.

ERROR. Check for the following typical issues:

a. You entered an incorrect NETBIOS name or IP address.

b.

PST Gatherer application or service on the client computer is not installed or not
running. You can start the Gatherer service on the respective computer from C:\Program

Files (x86)\Metalogix\MAM4Exchange\Tools\Start.

Register new clients

Instead of adding client computers one-by-one, you may want to add them automatically by
using the automatic registration as described below:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.

2. From the main menu click Clients and then select Automatic registrations.

[ Gatherer management

=
=
a

o
P

Clients | P5T

Add new client
Import clients
Delete clients

Client properties
Refresh

Default settings

0

Files:

d user |Desh’nat’on

FST file Name

User

Password | Destination Folder | Status

prd

Automatic registrations

Close

Close
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3. Inthe Registered clients window select the check boxes for each client computer that you want
to add. You can click Check all to select all client computers.

7 Registered clients o
6]
Known cliegnts:
Computer Name DomainMame | Username | IP Address
@AMXWINlO DEMOCCRP timashford fed0::a04a:ab2eee...
D@CZ#\EHBlD DEMOCCRP davidwebb fed0:: 34ch:9850:45. ..
D@DCCYU!HJ DEMOCCRP ishnamohan fedl::das7:22ef:78...

e —

4. Click Create. The selected client computers will be added to the Clients list.

[ Gatherer management rPEE

Clients  PST
®E®O(» 00
Clients: Q Files:
Computer namel Status | Assigned user | Destination PST file Name User Password | Destination Folder | Status
@) AMKWINIGG  Orline timashford PsT

>

<
_

NOTE: If the client computer cannot be added, the Status column of the Clients list displays
ERROR. Check for the following typical issues:

a. Client computeris turned off.

b. PST Gatherer application or service on the client computeris not installed or not
running. You can start the Gatherer service on the respective computer from C:\Program
Files (x86)\Metalogix\MAM4Exchange\Tools\Start.
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Import new clients

You can use an import file to add a large number of pre-configured client computers. The import
TXT file format and considerations are described below:

Column name Value Description Example
Name string Computer name AMXWIN10
MBXID integer Mailbox identifier. Instead 6

of this column you can you
can use OwnerName column

DestinationFolder string Folderin the target mailbox | %PSTFILENAME%
which will be the root folder
for the whole PST tree
structure. If you intend to
import more than one PST
file to the same destination
mailbox, you can create
unique root folders for each
PST file by entering the
special tags described
below:

a. %PSTNAME% - the folder
name is the display name
of the PST file.

b. %PSTFILENAME% - the
folder name is the file
name (without
extension) of the PST file

OwnerName string If you do not know the timashford@democorp.c
mailbox identifier (MBXID), | om
you can specify the email
address or alias

SearchStart datetime Date and time when the 21/1/2010 4:00:00 PM
Gatherer should start
searching for PST files

Searchinterval integer Frequency of the search 1
(days)



Column name Value Description Example

SearchDuration integer Duration of searching 20
(minutes)
UploadStart datetime Date and time when the 25/1/2010 4:00:00 PM

Gatherer should start
uploading of PST files

UploadIinterval integer Frequency of the upload 1
(days)
UploadDuration integer Duration of searching (days) | 30

. The first line must contain the columns which are used in the file. The file need not contain all

columns.
. The column Name is mandatory
Column names are not case sensitive.

. Column names and values must be separated by either a semicolon (;) ora pipe (|). Only one
type of the separator should be used in the whole import file.

. The data types must be correctly formatted:
e String - any string that does not contain separator. The string cab be empty.
¢ Integer -only numeric values.

e DateTime - the format of the date depends on the regional settings of the computer where
the application is running.

To import new client computers with an import file:

. From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.

. From the main menu click Clients and then select Import clients or click the Import clients icon
in the tool bar.



3 Gatherer management = e e

Clients | PST

Add new client

Y © B ol@a

Impert clients |

Q Files:

d user | Destination PST file Name | User Password | Destination Folder |
prd

Delete clients

Client properties
Refresh

Default settings

Automatic registrations

Cloze

£ >

3. Inthe Import PST Clients window click Import and locate the import file you have created.

Import PST Clients

]

| Impork |

Report:

4. Check the displayed report and the Clients list for imported clients.

5. Click Clear Report to erase the report contents and then click Close to exit the Import PST
Clients window.

Remove a client

When a client computer is removed, PST files cannot be uploaded from that client computer. To
remove a client computer:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.
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2.

3.

3 Gatherer management

Clients  PXT

L
Clients: @ Files
Computer name| Skatus | Assigned user | Destination I PST

H40a00CE Cnline Bdrmimiskrator PST

Select the client computer and then you can remove the clientin one of two ways:
a. Click the Remove Clienticon on the toolbar.

b. From the menu click Clients and then select Delete client.

Do wou want to remove the selected clients From the list?

| Yes | | Mo |

In the Information window that opens, click Yes to confirm.

Modify client properties

1.

2.

3.

From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.

In the Clients list select a client computer. Open the Properties window in one of three ways:
e Double-click a client computer in the Clients list.
e From the main menu click Clients and then select Client Properties.

e Right-click a client computer in the Clients list and select Properties from the context menu.

7 Gatherer management =E e
Clients  PST
E®Q »00Qld

Clients: Files:

Computer name | Status Assigned user | Destination PST file Name | User Password | Destination Folder | Status | Upload | Criginal path | Size |
i XV rgl Add new client mtlmashfor timashfor.. Mo default [] FOUMD Yes CiWsers\ti... Unknown
@  Delete client
Deactivate client
& v
Tasks 3

Close

From the Properties window select the Ownership tab.
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Client Properties - AMXWIN10 B
Ownership || Search || Upload

-@—;‘L_-EJLJ.L-L: LGl s ——

(* Detect user from folder path

|'|,'|,-5.rd1ive'|,‘5-‘nEMAIL.ﬁ.DRESS % |

(' Assignuser

|1J'mash1‘aru:| | Change

Customize the properties as described below:

a. Detect user from folder path - when PST files are stored on a network share or a disk drive
where each user has their own folder, you can specify the user's folder path or a search
string to identify the user's folder. PST files will be assigned to the user on the basis of the
folder name. If the user's folder cannot be found, no other folder will be used. You can use
the following wildcards to detect assignees:

* %ALIAS%

e %DISPLAYNAME%
¢ %LOGONNAME%
o %EMAILADRESS%

For example, if user folders are created on the basis of their email address on a network
share called Archive, then you can use the folder path \\Alias\%EMATILADRESSS to search
for PST files in these folders and assign each PST file to a unique user mailbox.

b. Assign user - Click Change to open the Select mailbox window and choose a user for PST
import. If the user's folder cannot be found, no other folder will be used.

¢. You can customize other settings in the Ownership, Search and Upload tabs as described in
the Setup PST Gathering topic.

Deactivate a client

If you want to temporarily prevent a client computer from automatically uploading PST files you
can deactivate the client instead of removing it. If a client is deactivated, manual uploading and
importing of PST files can still be performed. Manual uploading is an independent process from
automated uploading.

To deactivate a client computer:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.
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2. Right-click the client that you want to deactivate and select Deactivate client from the context
menu.

[ Gatherer management =E R

Clients  PST
BEQ » OO0 S

Clients: Q Files:

Computer namel Status | Assigned user | Destination | PST file Name User Password | Destination Folder | Status

AMXWINIO

Add new client
Delete client

Deactivate client |

Properties

Tasks 3

<
_

3. Adeactivated client is displayed with a red mark in the icon.

[ Gatherer management == e
Clients  PST

E®O(» 00

Clients: Q Files:

Computer name| Status | Assigned user | Destination PST file Name User Password | Destination Folder | Status

@ aMxwINiG  Orline timashford PsT

£ >
_
»

1 | NOTE: A deactivated client computer can be activated again. Right-click a deactivated client
in the Clients list and select Activate client from the context menu.

Manage PST files

In this topic:

e Deactivate automatic upload

e Modify PST Properties
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Deactivate automatic upload

To prevent uploading a PST file :

1.

From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.

Select a client from the Clients list. The PST files found by the PST Gatherer are displayed in
the Files list.

Right-click a PST file and then select Deactivate automatic upload from the context menu. The
status of the Upload column changes to No.

3 Gatherer management PER
Clients  PST

E®O/» 00

Clients: ] Files:

Computer name | Status Assigned user | Destination PST file Name | User Password | Destination Folder | Status | Upload | Origina_l&hl Size H

@amxwinig  Error timashford imashfor... tmashfor... Mo Activate automatic upload C:\Usersiti... Unknown

Deactivate automatic upload |

Uplead filels)

@  Deletefile(s) from list
Show error information
Analyze PST file owner

Change PST file owner

Properties

_ C|DSE

NOTE: Deactivated PSTs can be activated again. Right-click a deactivated PST file and then
select Activate automatic upload from the context menu. The status of the Upload column
changes to Yes.

Modify PST Properties

To change properties of a PST file:

1.

From the PST Importer menu click PST Gathering and then click Clients and PST files. The
Gatherer management window opens.

Select a client from the Clients list. The PST files found by the PST Gatherer are displayed in
the Files list.

Right-click a PST file and then select Properties from the context menu.
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7 Gatherer management =R

Clients  P5T
E®SQ(»00Q0 s
Clients: gl Files:
Computer name | Status Assigned user | Destination User Password | Destination Folder | Status | Upload | Origina_l&i'll Size H
@AMKWINlO Error timashford for... tmashfor... MNo Activate automatic upload C:\Usersiti... Unknown

Deactivate automatic upload

Upload file(s)
@  Deletefile(s) from list

Show error information

Analyze PST file owner

Change PST file owner

[E5' eroperties |

Close

4. Inthe Properties window that opens, modify the properties as described below:

PST Properties - test1.pst B
Settings | Details
&.ﬁn@a'&jjm]lbu;: apthiullzp L —

Target mailbox:

|<:deFauIt:= | EBrowse

Tarqget Folder:
% Default Folder {defined on client)

™ specific folder

| | Browse |

Mimml—gp'ﬂun; —

¥ allow to upload file to server

[ Always analyze before import

ok || cancel | ool

Settings tab

a. Target mailbox - sets a specific owner mailbox for the PST file. To change the target
mailbox, click Browse to open the Select mailbox window and choose the new owner
mailbox. Click Default to reset the mailbox to the default setting. You can also right-click
the PST file and select the Change PST file owner from the context menu

b. Default folder - select this option to use the default folder.

c. Specific folder - select this option to define a specific target folder. Either type the mailbox
folder name in the text box or use the Browse button to select a mailbox folder.

i | NOTE: If you intend to import more than one PST file to the same target mailbox,
you can create unique root folders for each PST file by entering the special tags
described below:
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a. %PSTNAME% - the folder name is the display name of the PST file.

b. %PSTFILENAME% - the folder name is the file name (without extension) of the
PST file

For example, if Maya-2019.pst is the file name of the PST folder being imported and
you enter PST Archive/%$PSTFILENAMES in the Destination folder, then a folder
hierarchy will be created under the destination mailbox root as PST Archive > Maya-
2019.

d. Allow to upload file to server - allows the PST file to be uploaded. If this check box is not
checked the PST file will not be uploaded.

e. Always analyze before import - select this check box to use the Analyze function to identify
a PST owner.

Details tab

a. Ifthe PSTfile is password protected, enter the password in the Password field and re-
enter the password in the Confirm password field.

5. Click OK to save the settings and exit the window or click Apply to save and continue.

Search for PSTs immediately

Searching for PST files on a specific client computer starts automatically at the start time
specified for that specific computer. You can start searching for PST files immediately if
necessary.

To start searching immediately:
1. From the PST Importer menu click PST Gathering and then click Clients and PST files.

2. Inthe Gatherer management window right-click the client you want to search. Select Tasks >
Search from the context menu. Searching starts immediately.
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I Gatherer management

=E R
Clients  PST
BEQ » OO0 S
Clients: Q Files:
Computer namel Status | Assigned user | Destination | PST file Name | User Password | Destination Folder | Status
AMXWIN10 @ Add new client
& Delete client
Deactivate client
Properties
| Tasks 4 || Search
Upload

Deactivate PST usage

e 08

Permanently deactivate PST usage =

3. Click the Refresh icon in the toolbar to view the results in the Files list. It may take a while
(maybe several minutes) to display the PST files as it depends on the number of disks that
have to be searched through, their size, and the number of files that have to be screened.

[ Gatherer management

BEE
Clients  P5T
E®=O »x00 s
Clients: 9] Files:
Computer name| Status | Assigned user | Destination PST file Mame | User | Password | Destination Folder | Status
@ amawNi  oOnline timashford

ﬁlﬁmashﬁurd.pst timashford... Mo default [PST] FOUMD

>

<
_

1 | NOTE: To clear the search results list when performing a new search, open PST Importer.

The click Tools > Options to open the Options window. On the Default tab select the Clear
existing list before a new search check box and save the setting.

Upload PSTs immediately

Files found by the PST Gatherer will be uploaded automatically depending on the upload start

time specified for that client computer. You can start uploading PST files immediately if
necessary.

To start uploading PST files immediately:
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1.
2.

3.

4.

From the PST Importer menu click PST Gathering and then click Clients and PST files.

In the Gatherer management window right-click the client for which you want to start the
immediate upload. Select Tasks > Upload from the context menu. PST file upload starts
immediately.

[ Gatherer management e R
Clients  PST

E®O(» 00 &

Clients: Q Files:

Computer namel Status | Assigned user | Destination | PST file Name | User | Password | Destination Folder | Status

ﬁlﬁmashfor... timashfor... Mo default [PST] FOUMD

A AMXWINIO

Add new client

Delete client

Deactivate client
Properties

| Tasks » |

Search

&

|@ Upload
)

6

Deactivate PST usage

Permanently deactivate P5T usage =

Click the Refresh icon in the toolbar and check the Status column in the Files list. The status
value changes from UPLOADING to UPLOADED or ERROR as files are uploaded.

I3 Gatherer management mER
Clients  PST

E®9(»00Q &

Clignts: Q Files:

Computer name| Status | Assigned user | Destination | P3T File Mame | User | Password | Destination Folder | Status | Upload | o]

online Adrinistrator PST EE Adrinistr,,, default[d... Mo defaulk [PST] UPLOADED  Yes C
m test1.pst default [d... Mo defaul: [PST] UPLOADED  Yes C
m user002.pst default [d... Mo default [PST] UPLOADED  Yes C
EE Export.pst  default[d... Mo defaulk [PST] UPLOADED  Yes C
ﬁl Administr.., defadlt[d... Mo defaul: [PST] ERROR Yes C
ﬁl testl.pst defadlt [d... Mo default [PST] FOUMD Yes C
ﬁl user00z.pst default [d... Mo defaulk [PST] FOUMD Yes C

If the upload status indicates ERROR then the PST file could not be uploaded. There could be
several reasons. For example, the file was deleted from the disk or the file was removed from
its original path after a search action. To analyze the error, right-click the PST file and select
Show error information from the context menu.
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32 Gatherer management EER
Clients  PST
E®9 » 00 &
Clients: Q Files:
| Compuker name| Status | Assigned user | Destination PST file Mame | Usey | Password | Destination Folder | Status | Upload | o]
@4DADDC2 orline Adrniniskrator PST @.Administr... defadlt [d... Mo default [P5T] UPLOADED  Yes C
ﬁitestl.pst default [d... Mo default [P5T] UPLOADED  Yes C
@.userﬂﬂ&pst defadlt [d... Mo default [PST] UPLOADED  Yes C
@.Export.pst defadlt [d... Mo default [P5T] UPLOADED  Yes C
. default[d... Enabl . load 5 (el
default [d... Mo nable autarmatic uploa - C
[Ruseronz.pst default[d... Mo Disable autamatic upload s C
Upload file(s)
Delete file(s) from list
Showe error information %J
Aralyze PET file cwner
Change PST file owner
Properties
NOTE: To re-upload one or more specific files from the Files list, initiate a search action on
the same client computer as described in the Search for PSTs immediately topic. When the
file gets displayed in the Files list, right-click the file and select Upload file(s) from the
context menu.
Import and archive uploaded PST files
PST files are imported by the PST Import wizard to their destination mailboxes and destination
folders and then archived.
To import and archive uploaded files:
1. From the PST Importer menu click PST Gathering and then click Clients and PST files.
2. Inthe Gatherer management window click the Import wizard icon to open the PST Import
wizard.
7 Gatherer management mEER
Clients  PST
®B®O x| 00[d
Clients: Q Files:
Computer name | Status Assigned user | Destination PST file Name | User Password | Destination Folder | Status | Upload | Criginal path | Size |
AMXWINIO  Error timashford ﬁltimashfcr... timashfor... Mo default [PST] UPLOADED  Yes CiWsers\ti... Unknown
E——
3. The Mailbox Action window displays the list of uploaded PST files. Select the files which you
want to import.
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PST import wizard

&

Mailbox Action

Select PST files to import

Clienk | Ziwner | Path | Status | Size |
[#] AMXWINID timashford Cilinstalitimashf... UPLOADED  120273...

e

4. Click Next. The Summary window opens. Verify that the PST files selected forimport appear
inthe Summary list.

Import wizard - importing PST files

Summary

Summary:

Following files were selected:
C:\Users\timashford\Documents\timashford. pst @ -1

Number of threads:

T e

Number of threads - set the number of threads to process the import. The more the threads,
the higheris the import speed. However, it means also a higher network load.

5. Click Finish to start the import.

6. Click Close when the import completes. Imported and archived PST file status in the Files list
of the Gatherer management window changes to PROCESSED.
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Troubleshooting

Cannot import PST file of any type
Probably the MAPI is not configured to use Microsoft Outlook data files (PST files).

Details: To use PST files in MAPI profiles, the Extended MAPI must know how to handle them.
The MAPISVC. INF file must contain the correct service provider entry to successfully use PST
files in Archive Manager.

If the MAPI subsystem is installed along with the MS Exchange Server, the MAPI binaries and the
MAPISVC.INF file are located in the folder c:\Program Files\Common
Files\System\Mapi\1033\NT. If the MAPIl is installed along with MS Outlook, the binaries
are located in c: \WINNT\system32.

The [Services] section should contain the following entries:
MSPST MS=Personal Folders

The service definition:
[MSPST MS]
Providers=MSPST MSP
PR_SERVICE DLL NAME=mspst.dll
PR _SERVICE INSTALL ID={6485D262-C2AC-11D1-AD3E-10A0C911C9CO0}
PR _SERVICE SUPPORT FILES=mspst.dll
PR_SERVICE_ENTRY_NAME=PSTServiceEntry
PR_RESOURCE_FLAGS=SERVICE NO PRIMARY IDENTITY
[MSPST MSP]
34140102=4e495441£f9pfb80100aa0037d96e0000
PR_PROVIDER DLL NAME=mspst.dll
PR _SERVICE INSTALL ID={6485D262-C2AC-11D1-AD3E-10A0C911C9CO}
PR RESOURCE TYPE=MAPI STORE PROVIDER
PR RESOURCE FLAGS=STATUS DEFAULT STORE
PR DISPLAY NAME=Personal Folders
PRfPROVIDERiDISPLAY:Personal Folders

The same for [MSUPST MS] service.

Symptoms: If the above service providers are missing in the MAPISVC. INF file, the following
erroris displayed by Archive Manager (in debug output) when importing a PST file:

CProfileManager::PSTAdd >> Cannot create msg service MSPST MS
8004010F
CProfileManager: :PSTAdd >> Exception 8004010F
CProfileManager: :PSTAdd >> Cannot create msg service MSPST/MSUPST
MS %08X
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CProfileManager::PSTAdd >> Cannot create msg service MSUPST MS
8004010F
CProfileManager: :PSTAdd >> Exception 8004010F
CProfileManager: :PSTAdd >> Cannot create msg service MSPST/MSUPST
MS %08X

Remark: The error code 8004010F stands for MAPI_E_NOT_FOUND and indicates that the
required data was not found on the object. (e.g. the MSPST MS service provider was not found)

Cannot import Unicode PST files

Probably the MAPI is not configured to use Unicode PST files or no Outlook was installed on the
PST Importer server.

Details: The service provider MSUPST MS must be included in the MAPISVC.INF file. For
detailed description of the MAPTISVC. INF file see question Q1.

Symptoms: The following lines can appear in the debug output:

CProfileManager::PSTAdd >> Cannot create msg service MSUPST MS
8004010F
CProfileManager: :PSTAdd >> Exception 8004010F
CProfileManager: :PSTAdd >> Cannot create msg service MSPST/MSUPST
MS %08X

Remark: The error code 8004010F stands for MAPI_E_NOT_FOUND and indicates that the
required data was not found on the object. (e.g. the MSPST MS service provider was not found)
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About Us

Quest creates software solutions that make the benefits of new technology real in an
increasingly complex IT landscape. From database and systems management, to Active Directory
and Office 365 management, and cyber security resilience, Quest helps customers solve their
next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune
500 count on Quest to deliver proactive management and monitoring for the next enterprise
initiative, find the next solution for complex Microsoft challenges and stay ahead of the next
threat. Quest Software. Where next meets now. For more information, visit www.quest.com.

Contacting Quest

For sales or otherinquiries, visit www.quest.com/contact.

Technical Support Resources

Technical support is available to Quest customers with a valid maintenance contract and
customers who have trial versions. You can access the Quest Support Portal at
https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal activates you to:

e Submit and manage a Service Request
e View Knowledge Base articles
e Sign up for product notifications

Download software and technical documentation

View how-to-videos

e Engage in community discussions

Chat with support engineers online

e View services to assist you with your product
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